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1. Introduction 
The Care Coordination (CC) Standardized Episodes of Care (SEOC) is a reference database for 
managing care bundles for use by Veterans Information Systems and Technology Architecture 
(VistA) and other Department of Veterans Affairs (VA) systems. Services are grouped together 
within the SEOC system into bundles so that clinicians can add these bundles to patients consult 
records in a standardized fashion, reducing the amount of time spent manually entering consult 
instructions, and providing uniformity among the patient records and across facilities for how 
patient care is prescribed for similar complaints. 
These bundles group together one or more services that are preselected for different specialties to 
be added to the consult records. In addition, the clinician is provided with information regarding 
prescribing rules and preauthorization requirements, so they can make the most informed 
decisions regarding patient care. 
Additionally, SEOC data will be accessible outside of the VistA/Computerized Patient Record 
System (CPRS) system so that users of downstream applications will be accessing the 
centralized data, and SEOC descriptions, reducing the chances of disconnects. 

1.1. Purpose 
The purpose of this document is to provide instruction for utilizing the SEOC application to 
standardize and streamline consult management for Community Care. 

1.2. Document Orientation 
The Care Coordination (CC) Standardized Episodes of Care (SEOC) v1.9 User Guide will 
provide explanations of each screen and of all user interface options within the context of an easy 
to understand demonstration data scenario.  
This document is also designed to provide the user with screen-by-screen “how to” information 
on the usage of CC SEOC. 

1.2.1. Organization of the Manual 
Section 1: Introduction 
The Introduction section provides the purpose of this manual, an overview of the SEOC 
software, an overview of the software used, project references, contact information for the user 
to seek additional information, and an acronyms and abbreviations list for this manual. 
Section 2: System Summary 
The System Summary section provides a graphical representation of the equipment, 
communication, and networks used by the system, user access levels, how the software will be 
accessed, and contingencies and alternative modes of operation. 
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Section 3: Getting Started 
Information for the Getting Started section provides a general walk-through of the system from 
initiation through exit, enabling the user to understand the sequence and flow of the system. 
Section 4: Using the Software 
This section gives the user the “how to” information to use SEOC, including many step-by-step 
procedures. 
Section 5: Troubleshooting 
This section provides troubleshooting for the SEOC user. 
Section 6: Acronyms and Abbreviations 
This section provides a list of acronyms and abbreviations found in this document. 

1.2.2. Assumptions 
This guide was written with the following assumed experience/skills of the audience: 

• The SEOC user has basic knowledge of the SEOC system (such as the use of commands, 
menu options, and navigation tools). 

• The SEOC user has been provided the appropriate active roles, menus, and security keys 
required for the SEOC User Interface (UI), as defined below in User Roles.  

• The SEOC user is using SEOC to perform their daily consult creation workflow and 
perform the required SEOC functions. 

• The SEOC user has validated access to the SEOC UI. 
• The SEOC user has been provided training on the SEOC UI and has reviewed the User 

Guide. 
• SEOC Content Authors: The SEOC Content Authors are responsible for creating and 

update the content within the SEOC repository using the SEOC UI. These users are 
required to VA access rights and privileges and will sign on to the SEOC application 
using their SSOI credentials (typically their PIV and access code). 

• CPRS Clinicians that are responsible for documenting patient consult records. These 
clinicians utilize the SEOC content as part of their daily consult creation workflow such 
that they will add a SEOC bundle to the patient consult record which will provide for a 
standardized documentation and care plan approach across the VA for these consults. 

1.2.3. Coordination 
One Consult - Consult Toolbox 1.9.02 and above and the HealthShare Referral Manager 
(HSRM) depend on the availability of the SEOC System. Consult Toolbox 1.9.02 requires active 
SEOCs whereas HSRM requires active and discontinued SEOCs. Coordination between the One 
Consult – Consult Toolbox, HSRM, and SEOC team is necessary with any updates to SEOC.  
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1.2.4. Disclaimers 

1.2.4.1. Software Disclaimer 
This software was developed at the Department of Veterans Affairs (VA) by employees of the 
Federal Government in the course of their official duties. Pursuant to title 17 Section 105 of the 
United States Code this software is not subject to copyright protection and is in the public 
domain. VA assumes no responsibility whatsoever for its use by other parties, and makes no 
guarantees, expressed or implied, about its quality, reliability, or any other characteristic. We 
would appreciate acknowledgement if the software is used. This software can be redistributed 
and/or modified freely provided that any derivative works bear some notice that they are derived 
from it, and any modified versions bear some notice that they have been modified. 

1.2.4.2. Documentation Disclaimer 
The appearance of external hyperlink references in this manual does not constitute endorsement 
by the Department of Veterans Affairs (VA) of this Web site or the information, products, or 
services contained therein. The VA does not exercise any editorial control over the information 
you may find at these locations. Such links are provided and are consistent with the stated 
purpose of the VA. 

1.2.5. Documentation Conventions 
This manual uses several methods to highlight different aspects of the material. 

Table 1. Documentation Symbols and Descriptions 

Symbol Description 

 

CAUTION: Used to caution the reader to take special notice of critical information. 

NOTE: Notes are used to inform the reader of general information including references to 
additional reading material. 

1.2.6. References and Resources 
Readers who wish to learn more about CPRS and CC SEOC should consult the VA Software 
Document Library. 

1.3. National Service Desk and Organizational Contacts 
For issues related to the CC SEOC that cannot be resolved by this manual or the site 
administrator, please contact the National Service Desk at 855-NSD-HELP (673-4357). 

2. System Summary 
There was an immediate need to provide clinicians the ability to quickly and consistently add 
care bundles to a patient’s consult record within VistA. SEOC provides this feature for a higher 
level of uniformity in patient care, easier access to appropriate services, based on initial 

https://www.va.gov/vdl/
https://www.va.gov/vdl/
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diagnoses, and the ability to better control care costs. SEOC allows clinicians to enhance the 
coordination of care for the Veteran. 
The system contains SEOCs, or care bundles, that clinicians or other designated individuals can 
assign to VA patients. These bundles allow for the consistent use of procedures when certain 
conditions are diagnosed. This consistency allows the VA to effectively manage patient care and 
provides easier traceability. 

2.1. System Configuration 
The SEOC System is designed to be a simple reference database with a supporting SEOC API 
and User Interface (UI) layer. The SEOC system comprises three application tiers as shown 
below. 

Figure 1: Overview of SEOC System 

 
The first tier is the Data Tier. This tier contains SEOC data. SEOC uses Microsoft Structured 
Query Language (SQL) Server is the database. SEOC data consists of reference data, such as 
SEOC name, associated procedures, associated Current Procedural Terminology (CPT) codes, 
procedure durations, etc. Additionally, user role information is maintained within the tables, but 
no passwords or other credentials are stored. No PHI or PII is stored in the database. SEOC data 
is associated with patient data in the VistA consult record. 
The second tier is the Abstraction Tier. This tier acts as the data broker for the SEOC system. It 
is a REST Application Programming Interface (API), built as a microservice hosted on container 
infrastructure (Docker Container). The API itself is built on the Spring MVC framework. The 
API receives web API calls that are forwarded to the database appropriately. Consuming 
applications are able to query the SEOC system through the SEOC REST API but will not be 
able to perform updated operations. The SEOC UI uses certificates to authenticate with the 
SEOC REST API to allow data modification within the SEOC system by authenticated users. 
Users are authenticated using SSOI. Additionally, a VistA/MUMPS patch is created to insert the 
SEOC associations into File # 123. 



CC SEOC v1.9 
User Guide 5 September 2019 

The third and final tier is the Presentation Tier. This tier consists of the SEOC UI, which 
provides a user interface for approved, authenticated users to maintain the SEOC collection. This 
application is a web application built as a microservice hosted on container infrastructure 
(Docker Container). The UI is built using the React.js JavaScript framework for web 
applications.  

2.2. Data Flows 
Figure 2: SEOC Data Flow Diagram 

 

2.3. User Access Levels 
SEOC user profiles comprise of the following “types of users”: 

• SEOC Content Authors: The SEOC Content Authors are responsible for creating and 
update the content within the SEOC repository using the SEOC UI. These users are 
required to VA access rights and privileges and will sign on to the SEOC application 
using their SSOI credentials (typically their PIV and access code). 

• CPRS Clinicians that are responsible for documenting patient consult records. These 
clinicians utilize the SEOC content as part of their daily consult creation workflow such 
that they will add a SEOC bundle to the patient consult record which will provide for a 
standardized documentation and care plan approach across the VA for these consults. 
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• SEOC data is also accessible to other external consumers in the future (in addition to 
CPRS users). The SEOC API is a RESTFul API that other (to be determined) users will 
have access to use. 

2.4. Continuity of Operation 
The SEOC system is maintained by Enterprise Operations (EO). The continuity of operations is 
managed by EO.  

3. Getting Started 
This section provides a general walkthrough of CC SEOC from initiation through exit.  

3.1. Logging On 
CC SEOC is accessed using the VA Single Sign-On Internal (SSOi) log in using the following 
URL: https://seoc.va.gov/ 

Figure 3: VA Single Sign-On for SEOC 

 

NOTE: After 15 minutes of inactivity the system will automatically log you out. After 13 
minutes of inactivity the system will prompt you to extend your session. 

https://seoc.va.gov/
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Figure 4: 2 Minutes Until Session Expires Warning 

 

3.2. System Menu 
The Standardized Episodes of Care home page offers seven features: Filter by Status, Filter by 
Name, Manage Users, Export SEOC Data, Manage Billing Codes, View Selected SEOC, 
and Draft New SEOC. The home page also displays the user name at the top right of the page. 

Figure 5: Standardized Episodes of Care Home Page 

 
Standardized Episodes of Care table fields: 

• Service Line – A broad category of care for the services and procedures included which 
is intended to be used to group and filter SEOCs for easier accessibility. A standardized 
three-letter abbreviation of the service line is included at the beginning of the SEOC ID. 

• SEOC Name – A unique title that categorizes a SEOC by specialty/subspecialty or area 
of clinical practice. 
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• Version – The version number of the SEOC. The version number is formatted A.B.C 
where the first digit will be 1, the second digit is the number of published SEOCs in the 
same Category of Care when a new SEOC is activated, and the third digit is a serialized 
revision number. 

• Effective Date –The date the SEOC status was made from In-Progress to Active. 
• End Date –The date the SEOC status was discontinued. 
• Status –The SEOC statuses are as follows:  

o Active: When a SEOC is Active, it will be available for all end users (e.g. API 
users, scheduling, payment, and auditing purposes).  

o Date Hold: When the SEOC status is Date Hold, it is pending and set for 
activation on a designated future date. This status is only available for SEOC 
Administrative users for editing purposes.  

o Discontinued: When a SEOC is Discontinued, read-only users will not have 
access to the discontinued SEOC in the SEOC Database and or the scheduling 
interface. However, the discontinued version will still be available for payment 
and auditing purposes. Discontinued SEOCs will remain in the SEOC database 
for up to six (6) years in the central repository. 

o In-Progress: The SEOC is available for editing purposes by the Administrators 
and Authors prior to activation. These SEOCs will not be available via SEOC 
Database API.  

3.3. Changing User ID and Password 
If you need to change your user password, you will need to contact your local PIV office. 

3.4. Exit System 
If you are finished working, log out of VA Single Sign-On and close any secure sessions that 
may still be open by clicking the Logout button. 

4. Using the Software 
The CC SEOC provides user functionality for the following items:  

• Manage Users 
o Viewing SEOC Users 

 Filtering Users 
o Delete a Selected User 
o Edit a Selected User 
o Add a New User 

• Export SEOC Data 
• Manage Billing Codes 
• Viewing SEOCs 

o View a Selected SEOC 
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o Search for a SEOC by Name 
o Filter SEOCs by Status 
o Discontinue a SEOC 
o Print a SEOC 

• Create a Draft SEOC 
o Edit a Draft SEOC 
o Activate a Draft SEOC 
o Delete a Draft SEOC 

• Create a Pending Revision 
• Payable Service List 

o View Payable Services 
o Delete Payable Services 

4.1. Manage Users 
4.1.1. Viewing SEOC Users 
To view the list of users in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

Figure 6: User Management 

 

4.1.1.1. Filtering Users  
To filter the list of users in SEOC by role or name, follow the steps listed below: 
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1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

2. To filter the list of users by role, select All, Viewer, Analyst, Author, Publisher, or 
Administrator from the Filter by Role drop-down menu. The list refreshes to display 
the role selected. 

3. To filter the list of users by name, enter the name in the Filter by Name (contains) field. 
The list refreshes to display the name or characters entered in the field. 

Figure 7: Filtered List by Name Example 

 

4.1.2. Delete a Selected User 
To delete a user from the User Management list, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

2. From the list of users, select the user that you would like to delete.  
3. Click Delete Selected User. A message displays confirming that you would like to delete 

the user. 
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Figure 8: Delete Selected User Confirmation 

 
4. Click Confirm Deletion. The user is deleted from the list. 

4.1.3. Edit a Selected User 
To edit a user in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

2. From the list of users, select the user that you would like to edit. 
3. Click Edit Selected User. The editable fields display. 

Figure 9: Editable User Fields 

 
4. Edit the User Name, Role, VA Network ID, and Domain fields as needed. 
5. Click Save. The updated user will display in the list of users. 

4.1.4. Add a New User 
To delete a user from the User Management list, follow the steps listed below: 
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1. From the SEOC Admin home page, click Manage Users. The User Management 
window displays. 

2. Click Add New User. 

Figure 10: Add New User Fields 

 
3. In the User Name field, enter the users name. 
4. From the Role menu, select Viewer, Analyst, Author, Publisher, or Administrator. 
5. In the VA Network ID field, enter the name of the VA network. 
6. In the Domain field, enter the name of the domain.  

4.2. Export the SEOC Data to a JSON File 
To export the SEOC Data, follow the steps listed below: 

Figure 11: Export SEOC Data 

 
1. As an Analyst, Publisher, or Administrator on the SEOC Admin home page, click 

Export SEOC Data. A dialog displays indicating the data is being downloaded. 
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Figure 12: Export SEOC Data Dialog 

 
2. If needed, click Cancel on the dialog to cancel the data download. 

4.3. Export the SEOC PreCert Data to a JSON File 
For all users who can Export SEOC Data, the SEOC Admin UI also allows them to export the 
data required for the VA PreCert Website. 
To export the SEOC PreCert Data, follow the steps listed below: 

Figure 13: Export SEOC Data 

 
1. As an Analyst, Publisher, or Administrator on the SEOC Admin home page, click 

Export PreCert Data. A dialog will appear indicating the data is being downloaded. 

Figure 14: Export SEOC PreCert Data Dialog 

 
2. If needed, click Cancel on the dialog to cancel the data download. 

NOTE: Please refer to Appendix A for additional steps on converting the JSON file into an 
Excel file. 

4.4. Managing Billing Codes 
NOTE: When updating the Billing Codes, SEOC will go into maintenance mode. SEOC users 

will be unable to update the system until the Admin has completed managing the billing 
codes. 

NOTE: Maintenance mode can be turned off by any Admin. 

NOTE: When you click on Return to SEOC list from Billing Code Management, it will 
automatically turn maintenance mode off. 
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To manage the billing codes in SEOC, follow the steps listed below: 
1. From the SEOC Admin home page, click Manage Billing Codes. The Billing Code 

Management window displays. 

Figure 15: Billing Code Management  

 
From the Billing Code Management window, you can delete billing codes and edit billing codes. 

4.4.1. Deleting Billing Codes 
To delete billing codes in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Billing Codes. The Billing Code 
Management window displays. 

2. From the list of billing codes, select the code that you would like to delete. 
3. Click Delete Billing Code.  

Figure 16: Confirm Delete Billing Code Message 
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NOTE: Verify that you want to delete the billing code listed, as the changes will affect the 
SEOCs listed in the Active and In-Progress tables. 

4. Click Confirm. A message will display confirming that that the billing code was deleted 
and the billing code will no longer display in the list. 

Figure 17: Billing Code Deletion Confirmation Message 

 

4.4.2. Editing Billing Codes 
To manage the billing codes in SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Manage Billing Codes. 
2. From the list of billing codes, select the code that you would like to edit. 
3. Click Edit Billing Code. The Edit Billing Code fields display. 
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Figure 18: Edit Billing Code 

 
4. Update the Billing Code field as needed. The maximum number of characters for this 

field is 25.  
5. From the Type field, select the correct option: CPT, DRG, HCPCS, HIPPS. 
6. Update the Description field as needed. The maximum number of characters for this 

field is 2,000. 
7. From the PreCert Required field, select the correct option: NO or YES. 
8. Click Continue. 

Figure 19: Edit Billing Code Confirmation Message 

 

NOTE: Verify that you want to delete the billing code listed, as the changes will affect the 
SEOCs listed in the Active and In-Progress tables. 
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9. Click Confirm. A confirmation message will display stating that the edits were made to 
the billing code. 

4.5. View SEOCs 
4.5.1. View a Selected SEOC 
To view a SEOC from the SEOC list, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to view. 
2. Click View Selected SEOC. The View SEOC page displays. 

Figure 20: View SEOC 

 

4.5.2. Search for a SEOC by Name 
To search for a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, enter the name of the SEOC in the Filter by Name 
(contains) field.  

Figure 21: SEOC Filter Field 

 
2. Click the Search button. The Search SEOC Results displays. 
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Figure 22: Search SEOC Results 

 

4.5.2.1. Sort SEOCs Alphabetically by Name 
To sort the list of SEOCs alphabetically by name, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC Name Column Heading. This will 
sort the list of SEOCs in alphabetical order by name. 

Figure 23: SEOC Name Column Heading 
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Figure 24: SEOC List Sorted in Alphabetical Order by Name 

 
2. To sort the list of SEOCs in reverse alphabetical order, select the SEOC Name Column 

Heading again. 

Figure 25: SEOC List Sorted in Reverse Alphabetical Order by Name 

 

NOTE: To return to the default sort order, either refresh the page or click the logo in the 
upper-right-hand corner of the page. 



CC SEOC v1.9 
User Guide 20 September 2019 

4.5.3. Filter SEOCs by Status 
To filter the list of SEOCs by status, follow the steps listed below: 

1. From the SEOC Admin home page, select Filter By Status menu. 

Figure 26: Filter by Status Menu Options 

 
2. From the list of options select to filter by: All, Active, Date Hold, Discontinued, or In-

Progress. The SEOC list refreshes to display the status filtered by. 

4.5.4. Discontinue a SEOC 
To discontinue a selected Active SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to discontinue. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Discontinue SEOC. The discontinue SEOC confirmation dialog box displays. 

Figure 27: Discontinue SEOC Confirmation 

 
4. Click Confirm Discontinue. The View SEOC page displays with the updated status of 

the SEOC. 
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Figure 28: Discontinued Status 

 

4.5.5. Print a SEOC 
To print a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to print. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Print SEOC. The printed SEOC will display in another window. Print or save 

using local browser capabilities. 
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Figure 29: Printed SEOC Window 

 

4.5.6. Invalid Characters 
The following business rules for valid characters are enforced in the SEOC Admin UI: 

• For the Description, Procedural Overview, and Additional Information fields in a 
SEOC, and the Description field in a Payable Service, the following characters are 
accepted: 

o Line Feed (ASCII 10) 
o Carriage Return (ASCII 13) 
o The printable ASCII characters (ASCII 32 – 126) except the DELETE character 

(ASCII 127) 
• For the SEOC Name, the above characters are accepted except: 

o & - Ampersand (ASCII 38) 
o / - Slash (ASCII 47) 
o : - Colon (ASCII 58) 
o \ - Backslash (ASCII 92) 
o ^ - Caret (ASCII 94) 
o | - Vertical Bar (ASCII 124) 
o ~ - Tilde (ASCII 126) 

• For a Billing Code value, the following characters are accepted: 
o Letters 
o Numbers 
o - Hyphen (ASCII 45) 
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o . - Period (ASCII 46) 
The user will not be able to activate a SEOC unless all of these rules have been followed.  In the 
case of the SEOC Name, the user will be unable to navigate past the SEOC Name and Service 
Line page of the Create / Edit SEOC Workflow if the SEOC Name has invalid characters.  
For Billing Codes, the user will be unable to save the Billing Code if the Billing Code value has 
invalid characters. 
The Show Invalid Characters feature allows the user to highlight invalid characters on any 
SEOC, regardless of status. 

4.5.6.1. Show Invalid Characters 
To show invalid characters on a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select a SEOC with invalid characters. 
2. Click View Selected SEOC, the View SEOC page will display. 
3. Click Show Invalid Characters. The Show Invalid Characters page will display. 

Figure 30: Show Invalid Characters Button 

 
 

Figure 31: Show Invalid Characters 

 
 

1. To print the SEOC with invalid characters shown, click Print SEOC.  The Print SEOC 
page will display with invalid characters shown. 



CC SEOC v1.9 
User Guide 24 September 2019 

Figure 32: Print SEOC from Show Invalid Characters Page 

 
 

Figure 33: Print SEOC from Show Invalid Characters (Bottom of the Page) 

 
2. To return to the View SEOC page from the Show Invalid Characters page, click the Hide 

Invalid Characters button. 
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Figure 34: Hide Invalid Characters Button 

 

NOTE: The Show Invalid Characters button is only available if the SEOC has invalid 
characters. 

4.5.6.2. Fix Invalid Characters 
Invalid characters in a SEOC can either be fixed manually through the Edit SEOC workflow, or 
automatically with the Fix Invalid Characters feature.  Invalid characters are fixed as follows: 

• |, ^, ~, \, /, and & in the SEOC Name will be replaced with spaces 
• ‘ or ’ will be replaced with ' 
• “ or ” will be replaced with " 
• • or · will be replaced with * 
• – or – will be replaced with – 
• All other characters will be replaced with a space 

To automatically Fix Invalid Characters, follow the steps listed below: 
1. From the SEOC Admin home page, select a SEOC with invalid characters. 
2. Click View Selected SEOC, the View SEOC page will display. 
3. Click Show Invalid Characters.  The Show Invalid Characters page will display. 
4. Click Fix Invalid Characters.  The Fix Invalid Characters confirmation dialog will 

display. 

Figure 35: Fix Invalid Characters Button 
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Figure 36: Fix Invalid Characters Confirmation 

 
5. Click Confirm Fix Characters.  A confirmation message will display. 

Figure 37: Invalid Characters Fixed Message 

 

NOTE: This feature is only available for In-Progress SEOCs.  For Active SEOCs with invalid 
characters, create a Pending Revision, then fix the invalid characters. 

4.5.7. Track Version Changes 
To track the version changes of a SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select a SEOC with a previous version. 
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2. Click View Selected SEOC, the View SEOC page displays. 
3. Click the Track Version Changes button when it becomes active.  The Track Version 

Changes page will display. 

Figure 38: Track Version Changes Page 

 
 

Figure 39: Track Version Changes: Additional Information and Provider Taxonomy Codes 

 



CC SEOC v1.9 
User Guide 28 September 2019 

Figure 40: Track Version Changes: Payable Services 

 
4. Click the Previous Version button. The changes for the previous version will be shown.  

If the previous version is the first version of this SEOC, no changes will be displayed. 
5. Click the Next Version button. The changes for the next version will be shown. 
6. Click the Print SEOC button. The Print SEOC page will display with the current 

changes. 

Figure 41: Print SEOC from Track Version Changes Page 
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Figure 42: Print SEOC from Track Version Changes: Additional Information and Provider 
Taxonomy Codes 

 

Figure 43: Print SEOC from Track Version Changes: Payable Services 

 

NOTE: By default, IE11 will not print the red and green background colors.  In order to print 
the red and green background colors, check the Print Background Colors and Images 
box in the Page Setup dialog from the Print menu. 
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4.6. Draft a New SEOC 
To draft a new SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, click Draft New SEOC. The Draft SEOC: Name 
window displays. 

Figure 44: Draft SEOC: Name 

 
2. In the SEOC Name field, enter the name for the new SEOC (required field). 
3. From the Service Line menu, select a service line (required field). 
4. Click Add/Edit SEOC Details. The Draft SEOC: Details window displays. 
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Figure 45: Draft SEOC Details  

 
5. From the Category of Care drop-down menu, select the category. 
6. In the Duration (days) field, enter the duration. 
7. From the PAL drop-down menu, select Yes or No. 
8. From the QASP drop-down menu, select a QASP: 

o Complimentary & Integrative Health Care 
o General Care 
o General Dental Care 
o Primary Care 
o Specialty Dental Care 

9. From the PAL drop-down menu, select No or Yes.  
10. In the Description field, enter a description for the procedure. The maximum amount of 

characters for this field is 500. 
11. In the Procedural Overview field, enter an overview on the procedure. The maximum 

amount of characters for this field is 5000. 
12. In the Additional Information field, enter additional information regarding the 

procedure. The maximum amount of characters for this field is 2000. 
13. Click Add/Remove HPTCs. The Add/Remove HPTCs window displays. 
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Figure 46: Add/Remove HPTCs 

 
14. Click Add new HPTCs to SEOC. A list of provider taxonomy codes displays. 

Figure 47: Provider Taxonomy Code List 

 
15. From the list of provider taxonomy codes select the HPTC to add to the SEOC. Another 

option is to use the Filter HPTC table by text (contains) field to filter the list of HPTCs 
and select the HPTCs from the filtered list. 

NOTE: You must add at least one HPTC to activate the SEOC. 
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16. Click Add highlighted HPTC to SEOC. A confirmation message displays telling you 
the HPTC was added. 

Figure 48: Draft SEOC: Provider Taxonomy Code Added Message 

 
17. Repeat steps 14-16 to add additional HPTCs to the SEOC 
18. When you are finished adding provider codes, click Done. The Draft SEOC: SEOC 

Provider Taxonomy Codes page will display. The table displays the provider codes you 
added on the previous page. 
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Figure 49: Draft SEOC: Added Provider Taxonomy Codes 

 
19. If needed, you can select an HPTC row and click Remove highlighted HPTC from 

SEOC to remove an HTPC.  The Confirm Remove HPTC dialog will display. Click 
Confirm to remove the HPTC from the SEOC. 

Figure 50: Draft SEOC: Confirm Remove HPTC 

 
20. Click Add/Edit Payable Services. The Draft SEOC: Payable Services window 

displays. 
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Figure 51: Draft SEOC: Payable Services  

 
21. Click Add New Service to SEOC. The Draft SEOC: Add Payable Service section 

displays at the bottom of the page. 

Figure 52: Draft SEOC: Add Payable Service  

 
22. In the Description field, which is required, enter a description for the payable service. 

NOTE: The maximum number of characters for the Description field is 2000. 
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23. In the Allowable Visits/Units field, enter the number of allowed visits. 

NOTE: The maximum value for the Allowable Visits/Units field is 999. 

24. Under the Clinical Service section, which are required, click Add Clinical Service. The 
Draft SEOC: Add Clinical Service dialog box displays. 

Figure 53: Draft SEOC: Add Clinical Service 

 
25. Enter text in the Search for Clinical Service field. Press Enter or click the Search 

button. The table displays all rows with the text you entered. 
26. Select the desired Clinical Service. 
27. Click Add Clinical Service to Payable Service. A confirmation message displays telling 

you the clinical service was added. 
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Figure 54: Draft SEOC: Clinical Service Added Message 

 
28. Repeat steps 24-26 to add additional Clinical Services to the Payable Service. 
29. Click Done. The clinical service displays in the Clinical Service field. 

Figure 55: Draft SEOC: New Clinical Services Added to the Payable Service 

 
30. If needed, select a Clinical Service row and click Remove Selected Clinical Service to 

remove a Clinical Service. 
31. In the Frequency (visits/interval) field, which is optional, enter the number of visits and 

select if it is per week, month, or year.  

NOTE: The maximum value for the Frequency (visits/inverval) field is 999. 

NOTE: If either the Frequency Visits or the Frequency Interval field is populated without the 
other, an error will be displayed if you click Done.  
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NOTE: If no billing codes are required, select No Code Required. 

32. If this service can accept any billing code, select Accept Any Code. 
33. If this service requires billing codes, click Add New Billing Code to Service. The Draft 

SEOC: Add Billing Code dialog box displays. 

Figure 56: Draft SEOC: Add Billing Code 

 
34. Enter text in the Search by billing code field. Press Enter or click the Search button. The 

table will display all rows where the Billing Code column starts with the text you 
entered. 

35. Select the desired Billing Code. 
36. Click Add Code to Payable Service. A confirmation message displays. 

Figure 57: Draft SEOC: Billing Code Added Message 
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37. Repeat steps 35-37 to add additional Billing Codes to the Payable Service. 
38. To define a new Billing Code, click Define New Code. The Define New Code form 

displays. 

Figure 58: Define New Code 

 

NOTE: If you had entered a billing code in the Search by Billing Code Field before clicking 
Define New Code, the Billing Code Field will be pre-populated with the value from 
the Search by Billing Code Field. 

NOTE: If the pre-populated value for the Billing Code Field starts with a letter, the Type 
menu will default to DRG.  Otherwise, it will default to CPT. 

39. In the Billing Code field, which is required, enter the billing code. 

NOTE: The maximum number of characters for the Billing Code field is 25. 

40. From the Type menu, select the type of billing code (required field). 
41. In the Description field, which is required, enter the billing code description. 

NOTE: The maximum number of characters for the Description field is 2000. 

42. From the PreCert Required menu, select whether the billing code requires pre-
certification (required field). 

43. Click Add Code to Payable Service. The new code will be added to the current payable 
service. A confirmation message will display. It will also be available in the list of billing 
codes in the Add Billing Code dialog box. 
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Figure 59: Draft SEOC: New Billing Code Added Message 

 

NOTE: If any of the fields are not populated, or if there are any characters in the Billing Code 
field that are not letters, numbers, a hyphen, or a period, an error message will appear 
when you click Add Code to Payable Service. 

Figure 60: Duplicate Billing Code Message  

 
44. Click Done. The Draft SEOC: Add Payable Service section displays. 

Figure 61: Draft SEOC: Billing Codes Added to the Payable Service 

 
45. If needed, you can select a Billing Code row and click Remove Selected Code from 

Service to remove a Billing Code or to remove No Code Required or Any Code 
Accepted. 

46. Click Done. The Payable Services window displays. 
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Figure 62: Draft SEOC: Payable Service Added to SEOC 

 

NOTE: If any of the required fields are not populated, or if Allowable Visits/Units or 
Frequency are not numbers within the specified range, an error message will appear 
when you click Done. 

47. If needed, you can select a Payable Service row and click Remove Selected Service 
from SEOC to remove a Payable Service. The Confirm Delete Payable Service dialog 
will display. Click Confirm Deletion to remove the Payable Service. 

Figure 63: Draft SEOC: Delete Payable Service Confirmation 

 
48. You can also select a Payable Service row and click Edit Payable Service to edit the 

selected Payable Service. 
49. Click View SEOC. The information you entered will be displayed, including Provider 

Taxonomy Codes (HPTCs) and Payable Services. The In-Progress (New) status will 
display in the window. 
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Figure 64: Draft SEOC View 

 

Figure 65: Draft SEOC: View Provider Taxonomy Codes and Payable Services 

 

4.6.1. Edit an In-Progress SEOC  

NOTE: If a user attempts to edit a SEOC that another user is already editing, the user will 
receive a message stating that the request can’t be processed. 
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NOTE: If a user attempts to edit a SEOC while the system is in maintenance mode for Billing 
Code Management, the user will receive a message stating that the request can’t be 
processed. 

To edit a SEOC that is currently marked as In-Progress, follow the steps listed below: 
1. From the SEOC Admin home page, select the SEOC you would like to edit. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click EDIT SEOC. The Edit SEOC: Name window displays. 
4. Follow the workflow in the previous section to edit any fields as necessary. 
5. Click View SEOC to confirm the edits. 

4.6.2. Activate an In-Progress SEOC 
To activate a SEOC that is currently marked as In-Progress, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to activate. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Activate SEOC.  

NOTE: Once the SEOC is activated, the previous version status is automatically set to 
Discontinued. 

4. If there are activation errors, the Activation Error dialog will display listing what needs 
to be resolved before the SEOC can be activated. 

Figure 66: SEOC Activation Errors 

 
5. If there are no activation errors, the Confirm Activation dialog displays. 
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Figure 67: SEOC Activation Confirmation 

 
6. The Effective Date will default to the next day at 12:01AM EST.  If needed, enter a new 

Effective Date in the input or click the calendar icon to select a date. 

Figure 68: SEOC Activation Confirmation Calendar 

 
7. Click Confirm Activation. A confirmation message will display. The Date Hold status 

will display in the upper-right-hand corner of the page. 
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Figure 69: SEOC Will be Activated Message 

 

NOTE: The SEOC will remain in Date Hold status until 12:01 AM EST on the specified 
Effective Date. At that time, the SEOC will change to Active status. 

Figure 70: Date Hold Status 
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4.6.3. Delete an In-Progress SEOC 
To delete a SEOC that is currently marked as In-Progress, follow the steps listed below: 

1. From the SEOC Admin home page, select the draft SEOC you would like to delete. 
2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Delete SEOC. The Confirm Deletion dialog box displays. 

Figure 71: Confirm Deletion  

 
4. Click Confirm Deletion. The SEOC is deleted from the SEOC List. 

4.7. Pending Revisions 
4.7.1. Create a Pending Revision 
To create a pending revision to an existing SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the active SEOC you would like to create a 
pending revision. 

2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Create Pending Revision. The Pending Revision: Name window displays. 
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Figure 72: Pending Revision: Name 

 

NOTE: To return to the SEOC Admin home page while editing a new SEOC or Revision, click 
Return to SEOC List in the bottom left-hand corner of any page in the Edit SEOC 
workflow. 

4. Update the SEOC Name and Service Line as needed. 
5. Click Add/Edit SEOC Details. The Pending Revision: Details window displays. 

Figure 73: Pending Revision: Details 
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6. Update the details for the SEOC as needed. 
7. Click Add/Remove HPTCs. The Pending Revision: SEOC Provider Taxonomy 

Codes window displays. 

Figure 74: Pending Revision: SEOC Provider Taxonomy Codes 

 
8. Update the Provider Taxonomy Codes (HPTCs) for the SEOC as needed. 
9. Click Add/Edit Payable Services. The Pending Revision: Payable Services window 

displays. 
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Figure 75: Pending Revision: Payable Services 

 
10. Update the Payable Services as needed. 
11. Click View SEOC. The Pending Revision status will display in the window. 

Figure 76: Pending Revision Status 

 
12. Click Return to SEOC List. The pending revision will display in the list of SEOCs. 
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Figure 77: Pending Revision Displayed in SEOC List 

 

4.7.2. Activate a Pending Revision 
To activate a pending revision, follow the steps listed below: 

1. From the SEOC Admin home page, select the Revision SEOC that you would like to 
activate. 

2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Activate SEOC.  
4. If there are activation errors, the Activation Error dialog will display listing what needs 

to be resolved before the SEOC can be activated. 

Figure 78: Revision Activation Errors 

 
5. The Confirm Activation dialog will display. 
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Figure 79: Pending Revision Activation Confirmation Message 

 
6. The Effective Date will default to the next day at 12:01AM EST. If needed, enter a new 

Effective Date in the input or click the calendar icon to select a date. 

Figure 80: Revision Activation Confirmation Date Calendar 

 
7. Click Confirm Activation. A confirmation message will display. The Date Hold Status 

will display in the upper-right-hand corner of the page. 
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Figure 81: Revision Will be Activated Message 

 

Figure 82: Date Hold Status 

 
8. Click Return to SEOC List. The pending revision that you just activated will display as 

Date Hold in the list of SEOCs. 

NOTE: The Revision will remain in Date Hold status and the previous SEOC will remain in 
Active status until 12:01 AM EST on the specified Effective Date.  At that time, the 
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Revision will change to Active status and the previous SEOC will change to 
Discontinued status. 

4.7.3. Revert a Date Hold SEOC back to In-Progress 
If you need to revert the selected SEOC to In-Progress, follow the steps listed below: 

1. From the SEOC Admin home page, select the Date Hold SEOC you would like to revert 
back to In-Progress. 

2. Click View Selected SEOC, the View SEOC page displays. 
3. Click Revert SEOC to In-Progress. The Confirm Revert SEOC to In-Progress dialog 

will display. 

Figure 83: Confirm Revert SEOC to In-Progress 

 
4. Click Confirm. The SEOC will be reverted back to In-Progress. 

4.8. Payable Service List 
4.8.1. View Payable Services 
To view the payable services for a selected SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to view the payable 
services for. 

2. Click View Selected SEOC, the View SEOC page displays. 
3. Scroll to the bottom of the page to view the Payable Services list. 
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Figure 84: View SEOC – Payable Services 

 

4.8.2. Delete Payable Service 
To delete payable services for a selected SEOC, follow the steps listed below: 

1. From the SEOC Admin home page, select the SEOC you would like to view the payable 
services for. 

2. Click View Selected SEOC, the Standardized Episode of Care – Provider 
Information page displays. 

3. From the View SEOC page, click Create Pending Revision. The Draft SEOC Name 
window displays. 

4. Click Add/Edit SEOC Details. The Draft SEOC Details window displays. 
5. Click Add/Remove HPTCs. The Add/Remove HPTCs window displays. 
6. Click Add/Edit Payable Services. The Draft SEOC Payable Services window displays. 
7. From the list of payable services, select the payable service that you would like to delete. 
8. Click Remove Selected Service from SEOC. A message will display confirming that 

you would like to delete the payable service from the SEOC. 
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Figure 85: Payable Service Confirm Deletion 

 
9. Click Confirm Deletion. The payable service is deleted from the list. 
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5. Troubleshooting 
Users may encounter the following errors while using the SEOC UI.  

Table 2: SEOC Error Codes with Descriptions 

Error Code Description 

204 No Content Found 

401 Unauthorized 

403 Forbidden 

404 Not Found 

6. Acronyms and Abbreviations 
Acronym Definition 
CAC Clinical Application Coordinators 

CC Care Coordination 

CCAD Community Care Agile Development 

CDW Corporate Data Warehouse 

CID Clinically Indicated Date 

CPRS Computerized Patient Record System 

HEC Health Eligibility Center 

HPTC Healthcare Provider Taxonomy Code 

JSON JavaScript Object Notification 

NSD National Service Desk 

OIT Office of Information and Technology 

PCP Primary Care Physician 

SAR Secondary Authorization Request 

SEOC Standardized Episode of Care 

VA Department of Veterans Affairs 

VDL VA Software Document Library 

VistA Veterans Health Information Systems and Technology Architecture 
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A. JSON Instructions 
NOTE: The steps outlined below are for Excel 2016. 

To convert the SEOC JSON file to an Excel file, follow the steps listed below: 
1. Select to download the SEOC JSON file. The Internet Explorer File Download Prompt 

displays at the bottom of the window. 
2. From the Save menu, select Save as. The Save As window displays. 
3. Select to download the file to the Desktop and click Save. 
4. Open a blank workbook in Excel 2016. 
5. Click the Data tab, then Get Data > From File > From JSON. The Import Data 

window displays. 

Figure 86: Import Data Window 

 
6. Select the JSON file you downloaded and click Import. Excel will open the file in the 

Query Editor. 
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Figure 87: Query Editor 

 
7. Click the List header to the right of Seocs to display a list of records. 

Figure 88: List of Records 

 
8. From the Transform tab, click the Convert To Table icon and click OK. The To Table 

dialog box displays. 



CC SEOC v1.9 
User Guide 59 September 2019 

Figure 89: To Table Dialog Box 

 
9. From the To Table dialog box keep the default selections and click OK. 
10. Click on the expand icon (<-||->) to the right of the Column1 header to display the 

Search Columns to Expand dialog box. 

Figure 90: Search Columns to Expand Dialog Box 
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11. De-select the Use original column name as prefix check box. 
12. Click OK. 
13. Click on the expand icon (<-||->) to the right of the Seoc header to display the Search 

Columns to Expand dialog box. 

Figure 91: Search Columns to Expand 

 
14. Uncheck the Use original column name as prefix check box. 
15. Click OK. The fields in the SEOC table will be expanded to columns as shown below. 
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Figure 92: Expanded SEOC Fields 

 
16. Scroll right to the services column, click on the expand icon, and select Expand to New 

Rows to display the records. 

Figure 93: Expand to New Rows Menu Option 

 
17. Click the expand icon again and press OK to expand the Payable Services fields into 

columns. 
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Figure 94: Payable Services Columns 

 
18. Scroll right to the billingCodes column and repeat the last two steps to expand the 

Billing Code fields into columns. 

Figure 95: Billing Code Columns 

 
19. Optional - Repeat the last two steps again for the serviceHptcs column if you want to see 

the cross-walked HPTCs that are sent for each Payable Service. 
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20. Scroll right and repeat the last two steps again for the hptcs column to expand the HPTC 
fields that were assigned to each SEOC.  

Figure 96: Expanded HPTC Fields 

 
21. Click the Close & Load option at the left of the ribbon to create load the imported data 

into a spreadsheet tab. 

Figure 97: Imported Data 
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